
On the Home tab, in the 
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 Volvo branded layouts. 
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internal presentations. 
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Volvo Broad Pro Digital 

does not work on Mac.  

You must save the 

 final version of  the  
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Compress Pictures 

Select the picture  

and dubble click. 

On the Format tab,  

in the Adjust group, 

click the Compress 

Pictures button. 

Only insert pictures 

that are in line with 

the Volvo tonality  

for pictures.  

See Volvo Brand 

Communication 

Guideline for  
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Volvo Profile colors 

Volvo Accent colors 

Only use these 

approved Volvo colors. 

Use the colors in 100% 

only – never in tints. 

For more information 

and RGB color codes 

please select the Volvo 

Layout “Volvo Brand 

Colors”. 

VOLVO  
CONSTRUCTION  
EQUIPMENT 
Corporate Presentation 2017 



Volvo CE Corporate Presentation 2017 

2 



Volvo CE Corporate Presentation 2017 

THE VOLVO GROUP 

3 



Day in and day out, all around the year, people’s decisions 

and basic needs create demand for transports and 

infrastructure solutions. Without the type of products and 

services the Volvo Group provides, the societies where many 

of us live would not function. Together we move the world. 

Volvo Group 2016 
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The Volvo Group is one of the world’s leading 
manufacturers of trucks, buses, construction 
equipment and marine and industrial engines. The 
Volvo Group also provides complete solutions for 
financing and service.  
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The Volvo Group, which 
employs about 100,000 
people, has production 
facilities in 18 countries 
and sales of products in 
more than 190 markets. 
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On the road 

At sea Off road  

In the city 
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Passion for customer success 

The majority of the Volvo Group’s customers are 
companies within the transportation or infrastructure 
industries. The realibility and productivity of the 
products are important and in many cases crucial to 
our customers success and profitability. 

Volvo CE Corporate Presentation 2017 
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The employer of choice 

Customer success 
We make our customers win. 

Trust 
We trust each other. 

Passion 

We have passion for what we do. 

Change 

We change to stay ahead. 

Performance 

We are profitable to shape our future. 
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Volvo Trucks UD Trucks 
Renault 

Trucks 
Mack Trucks 

Value Trucks 

& JV:s  

Volvo 

Construction 

Equipment 

Volvo Buses Volvo Penta 

Govern- 

mental  

Sales 

Volvo 

Financial 

Services 

Our Customers 

Business Areas 

CEO and Group 

Executive Board 

Group Functions 

Group 

Trucks 

Technology 

Group 

Trucks 

Operations 

Group 

Trucks 

Purchasing 

Truck Divisions 

Our Organization 



 

Vision  Our vision 

Be the most desired  

and successful transport solution 

provider in the world 

Volvo CE Corporate Presentation 2017 

11 



Our mission 

Driving prosperity through 

transport solutions 
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Global industrial structure 



Volvo Group 
2016, SEK bn 
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Operating income Net Sales 

11 12 13 14 15 

301,9 

16 11 12 13 14 15 

20,8 
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Volvo Construction Equipment 
2016, SEK bn 

Operating income Net Sales 

11 12 13 14 15 

50,7 

16 11 12 13 14 15 

2,2 
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• Develops, manufactures and  

markets equipment for construction 

and related industries  

• Broad range of products and  

services 

• Range of solutions in financing  

and used equipment 

• Part of the Volvo Group 
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* These figures exclude temporary employees,  

   hired services and consultants. 

Total as of January 2017 = 14,000 

Our employees 

7232 

1413 

5345 

10 

Europe

Americas

Asia

ROW



Our products 
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Customer solutions 

Volvo CE Corporate Presentation 2017 

Our products and services 

enhance the customer's 

experience and satisfaction 

and drive a greater brand 

experience 

Customer Solutions  

is a key contributor to 

Volvo CE’s business 

 

Customer Solutions is the 

part of the organization 

that creates products to 

engage customers 

throughout the entire 

machine lifecycle 
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FINANCIAL  

SERVICES 

RENTAL 

BUSINESS 

USED 

EQUIPMENT 
ATTACHMENTS 

PARTS 

SERVICE 

SOLUTIONS 
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HQ PLANTS REGIONAL SALES OFFICES HQ 

Volvo CE organization: a global company 
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Sales Regions 

APAC 

EMEA 

China 

Americas 

Volvo brand dealers: 45 

Locations: 244 

Sales persons: 488 

Technicians: 1 410 

Volvo brand dealers: 36 

Locations: 406 

Sales persons: 519 

Technicians: 2 312 

Volvo Brand Dealers:37 

Locations:282 

Sales persons:522 

Technicians:879 

Volvo brand dealers: 71  

Locations: 575 

Sales persons: 774 

Technicians: 2 992 

Volvo CE dealers globally 

Volvo Exclusive: 154 

SDLG Exclusive: 188 

Dual Brand (Volvo/SDLG): 58 

Terex Trucks Exclusive: 111 

Terex Trucks Multi Brand: 7 
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Safety first 
Always 

Our  
quality 

Environmental  
care 



SAFETY FIRST  
ALWAYS 
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Volvo Construction Equipment is a 

recognized industry leader in the field of 

safety. We approach safety on 3 levels: 

• PERSONAL SAFETY 

• WORKSITE SAFETY 

• MACHINE SAFETY 

By continuously improving products, 

tools and competence, we are step by 

step approaching our vision. 

A safe and healthy work environment 

People are the most important asset for 

Volvo Construction Equipment. Providing 

a safe and healthy work environment is 

essential to our business success. 

We are proactively addressing all 

improvement areas, contributing to the 

goal of being the most attractive 

employer in the industry! 
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Watch our SAFETY VIDEO on YouTube 

http://www.youtube.com/watch?v=qmiw5xANvWg
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ZERO ACCIDENTS  
WITH VOLVO PRODUCTS 

Our vision 



OUR  
QUALITY 
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27 



Volvo CE Corporate Presentation 2017 

• Volvo Construction Equipment’s 

commitment to quality starts by  

our vision is to be the model of 

excellence and care.  

• Delivering a total quality experience  

to Fleet Owners, Operational 

Managers as well as those who 

operate our machines is key. 

28 

Watch our QUALITY VIDEO on YouTube 

http://www.youtube.com/watch?v=0sqe78gJv8I
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TO DELIVER THE  
NUMBER ONE TOTAL  
QUALITY EXPERIENCE 

Our vision 



ENVIRONMENTAL 
CARE 
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Watch Volvo CE President Martin Weissburg  introducing the CCC on 

YouTube 

Volvo CE Corporate Presentation 2017 

• In 1972 Pehr G Gyllenhammar, former 

President and CEO, stated “We are 

part of the problem but also part of the 

solution”, and this is still valid.  

• 2015-2020 Climate Savers partnership 

with the World Wide Fund for Nature 

(WWF) addresses e.g.: 

– Increased machine fuel efficiency 

through improvements of existing 

products and advanced 

technologies 

– Production site energy efficiency 

– Customer site efficiency 

enhancements by improved 

operator behavior and machine 

utilization 

– Hosting of the Construction Climate 

Challenge (CCC) program.  

31 

http://www.youtube.com/watch?v=qCb2L-FDybw&feature=youtu.be
http://www.youtube.com/watch?v=qCb2L-FDybw&feature=youtu.be
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TO BECOME THE WORLD  
LEADER IN SUSTAINABLE 
TRANSPORT SOLUTIONS 

Volvo CE is part of Volvo  

Group’s WWF Climate Savers 

partnership. We are committed  

to be a climate leader within  

the global construction  

equipment industry. 

Our vision 



At Volvo CE we are driven by the idea that 
through imagination, hard work and 
technological innovation we will lead the 
way towards developing a world that is 
cleaner, smarter, and more connected. 
 
We believe in a sustainable future.  
And with the global construction industry  
as our arena, we work together with our 
customers to turn this belief into reality for 
people everywhere. That is our purpose,  
and we live and breathe it. Every day. 

OUR PURPOSE 

To build the world 
we want to live in 

Volvo CE Corporate Presentation 2017 
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INNOVATION LEADERSHIP 
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The Triple Zero –  
Our aspiration, Our challenge  
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The technology shifts 
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PRODUCT AND SERVICE LEADERSHIP 
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World’s biggest articulated hauler 

THE A60 
Volvo CE Corporate Presentation 2017 

38 



Efficient business partners 

22% MORE FUEL EFFICIENCY 

6.5 % GREATER PRODUCTIVITY 

17 % LESS FUEL CONSUMED  

  Volvo CE Corporate Presentation 2017 
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Volvo Co-Pilot shortlisted for human-
machine interface (HMI) award 

Volvo CE Corporate Presentation 2017 
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Electric load carrier concept wins 
prestigious global award  
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Only insert pictures 

that are in line with 

the Volvo tonality  

for pictures.  

See Volvo Brand 

Communication 

Guideline for  

further information 

Compress Pictures 

Select the picture  

and dubble click. 

On the Format tab,  

in the Adjust group, 

click the Compress 

Pictures button 

Company leadership 
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Martin 

Weissburg 

President 

Bill Law 

Corporate 

Communication 

Diana Niu 

Human Resources 

Edvard Carleson 

Legal 

Carl Lockwood 

Strategy 

Philippe Henriette 

Finance  

Anders Larsson 

Volvo CE Investment  

China and Lingong  

Integration Office  

Patrik Lundblad  

Technology 

Jean-Marc des 

Courieres 

Operations 

Thomas Bitter 

Marketing &  

Product Portfolio 

Image mssing 

Tomas Kuta 

Sales 



Only insert pictures 

that are in line with 

the Volvo tonality  

for pictures.  

See Volvo Brand 

Communication 

Guideline for  

further information 

Compress Pictures 

Select the picture  

and dubble click. 

On the Format tab,  

in the Adjust group, 

click the Compress 

Pictures button 

Industrial footprint Plant  R&D 

Motherwell, Scotland 

Shippensburg, US 

Pederneiras, Brazil  

Hameln, Germany Belley, France   Konz, Germany 

Hallsberg,  

Sweden 

Arvika,  

Sweden 

Braås, Sweden 

Eskilstuna,  

Sweden 

Kaluga,  

Russia 

Bangalore, India 

Linyi,  

China 

Changwon,  

Korea 

Shanghai, China 

Jinan, China 

Linyi, China 
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Pederneiras, Brazil  

Wrocław,  

Poland 

Pyeongtaek, 

Korea 
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Building; 29% 

Heavy 
Infrastructure, 

22% 

Road 
Construction; 

17% 

Agriculture & 
Landscaping; 

8% 

Quarries & 
Aggregates; 8% 

Mining; 5% 

Recycling & 
Waste; 4% 

Material 
Handling; 3% 

Forestry; 2% 

Utilities; 2% Oil & Gas; 1% 

Demolition; 1% 

Volvo CE Customer types and industry segments 

Contractor 
(Projects) 

64% 
Rental 

Provider 
17% 

Producer (Site 
Dependent) 

12% 

Governmental 
4% 

Other 
4% 

* As of December 2016 

Industry Segments* Customer Types* 
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The growth of Volvo CE 
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The evolution of our company 
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* As of December 2016 

48% 

6% 

20% 

11% 

15% 

48% Excavators

6% Haulers

20% Loaders

11% Road

13% Utilities

43% 

15% 

35% 

6% 1% 

42% Excavators

5% Haulers

42% Loaders

7% Road

4% Utilities

Volvo Construction Equipment* Industry (Volvo CE Portfolio)* 

Volvo CE vs. Industry:  
Share by Machine Range 
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* As of end of December 2016 

Europe 
17% 

North 
America 

35% 
Latin 

America 
5% 

China 
16% 

Asia 
Excl. 
China 
17% 

 RoW 
10% 

Europe 
39% 

North 
America 

19% 
Latin 

America 
3% 

China 
15% 

Asia 
Excl. 
China 
14% 

RoW 
10% 

Volvo Construction Equipment* Industry (Volvo CE Portfolio)* 

Volvo CE vs. Industry:  
Share by Region 
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• Complementary offer 

• Broader customer base 

Three distinct construction brands 
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Quarry & Aggregates 

Volvo CE Corporate Presentation 2017 

51 



Building 
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Utilities 
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Road construction 
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Oil & Gas 
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Demolition 
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Waste & Recycling 
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Forestry 
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Mining 
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